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DEPARTMENT OF ELECTRONICS & COMMUNICATION ENGINEERING 

Vision of the Institute: 

To produce ethical, socially conscious and innovative professionals who would contribute to 

sustainable technological development of the society. 

Mission of the Institute: 

To impart quality engineering education with latest technological developments and      

interdisciplinary skills to make students succeed in professional practice 

To encourage research culture among faculty and students by establishing state of art 

laboratories and exposing them to modern industrial and organizational practices 

To inculcate humane qualities like environmental consciousness, leadership, social values, 

professional ethics and engage in independent and lifelong learning for sustainable contribution 

to the society 

Vision of the Department: 

To strive to become centre of excellence in Education, Research with moral, ethical values and 

serve society 

Mission of the Department: 

M1: To provide Electronics & Communication Engineering knowledge   for   successful   career 

either in industry or research 

M2: To develop Industry-Interaction for innovation, product oriented research and development. 

M3: To facilitate value added education combined with hands-on trainings 

Program Educational Objectives: 

PEO 1: Apply the knowledge of Basic sciences and Engineering in designing and implementing 

the solutions in emerging areas of Electronics and Communication Engineering. 

PEO 2:  Pursue the research or higher education and practise profession. 

PEO 3: Adapt to the technological advancements for providing the sustainable Engineering 

solutions to meet organisation/society needs  

PEO 4: Work as an individual or in a team with professional ethics and values. 
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DEPARTMENT OF ELECTRONICS & COMMUNICATION ENGINEERING 

Program Outcomes: 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering 

problems.  

2. Problem analysis: Identify, formulate, review research literature, and analyze complex 

engineering problems reaching substantiated conclusions using first principles of mathematics, 

natural sciences, and engineering sciences.  

3. Design/development of solutions: Design solutions for complex engineering problems and 

design system components or processes that meet the specified needs with appropriate 

consideration for the public health and safety, and the cultural, societal, and environmental 

considerations.  

4. Conduct investigations of complex problems: Use research-based knowledge and research 

methods including design of experiments, analysis and interpretation of data, and synthesis of the 

information to provide valid conclusions.  

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities 

with an understanding of the limitations.  

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to 

the professional engineering practice.  

7. Environment and sustainability: Understand the impact of the professional engineering 

solutions in societal and environmental contexts, and demonstrate the knowledge of, and need 

for sustainable development.  

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and 

norms of the engineering practice.  

9. Individual and team work: Function effectively as an individual, and as a member or leader 

in diverse teams, and in multidisciplinary settings.  

10. Communication: Communicate effectively on complex engineering activities with the 

engineering community and with society at large, such as, being able to comprehend and write 

effective reports and design documentation, make effective presentations, and give and receive 

clear instructions.  

11. Project management and finance: Demonstrate knowledge and understanding of the 

engineering and management principles and apply these to one’s own work, as a member and 

leader in a team, to manage projects and in multidisciplinary environments.  

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage 

in independent and life-long learning in the broadest context of technological change. 

Program Specific Outcomes (PSOs): 

PSO1: Professional Competence: Apply the knowledge of Electronics & Communication  

 Engineering principles in different domains like VLSI, Signal processing, Communication, 

Embedded system & Control Engineering. 

PSO2: Technical Skills: Able to design and implement products using the cutting- edge 

software and hardware tools and hence provide simple solutions to complex problems. 

PSO3:  Social consciousness: Graduates will be able to demonstrate the leadership qualities 

and   strive for the betterment of organization, environment and society 
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DEPARTMENT OF ELECTRONICS & COMMUNICATION ENGINEERING 

 

LAB INSTRUCTIONS 

Lab Rule of conduct, DO’s & DON’Ts 

Conduct yourself in a responsible manner at all times in the laboratory. Don’t talk aloud or crack 

jokes in lab.  

A lab coat should be worn during laboratory experiments.  

Dress properly during a laboratory activity. Long hair, dangling jewellery and loose or baggy 

clothing are a hazard in the laboratory.  

Observe good housekeeping practices. Replace the materials in proper place after work to keep 

the lab area tidy.  

Do not wander around the room, distract other students, startle other students or interfere with 

the laboratory experiments of others.  

Do not eat food, drink beverages or chew gum in the laboratory and do not use laboratory 

glassware as containers for food or beverages.  

Rules & Guidelines for conducting Lab-Work 

Students are not allowed to touch any equipment, in the laboratory area until you are instructed 

by Teacher or Technician. � 

Before starting Laboratory work follow all written and verbal instructions carefully. If you do 

not understand a direction or part of a procedure, ASK YOUR CONCERNED TEACHER 

BEFORE PROCEEDING WITH THE ACTIVITY. �  

Before use equipment must be read carefully Labels and instructions. Set up and use the 

equipment as directed by your teacher. � If you do not understand how to use a piece of 

equipment, ASK THE TEACHER FOR HELP! �  

Perform only those experiments authorized by your teacher. Carefully follow all instructions, 

both written and oral. Unauthorized experiments are not allowed in the Laboratory. � Students 

are not allowed to work in Laboratory alone or without presence of the teacher. � Any failure / 

break-down of equipment must be reported to the teacher. Protect yourself from getting electric 

shock. 
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DEPARTMENT OF ELECTRONICS & COMMUNICATION ENGINEERING 

Course Code Course Title Core/ Elective 

PC751EC MICROWAVE LAB Core 

Prerequisite Contact  Hours  per Week 
CIE SEE Credits 

 
L T D P 

- - - 2 25 50 1 

Course Objectives: 

1. Understand the characteristics of RKO and Gunn oscillator.  

2. Measurement of frequency and wavelengths would be learnt by the student.  

3. VSWR various TEES would be understood by the student.  

4. Radiation pattern would be learnt by the student for horn antenna.  

5. How to Create, Simulate and analyse the different types of Microstrip Antennas by using EM 

simulation   software.  

⮚  
Course Outcomes: 

1. Understand the characteristics of RKO and Gunn oscillator.  
2. Measurement of frequency and wavelengths would be learnt by the student.  

3. VSWR various TEEs would be understood by the student.  
4. Radiation pattern would be learnt by the student for horn antenna.  
5. How to Create, Simulate and analyse the different types of Microstrip Antennas by using EM 

Simulation software.  

 

⮚  
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PART- A 

1. Characteristics of Reflex Klystron oscillator, finding the mode numbers and efficiencies 

of different modes.  

2. Characteristics of Gunn diode oscillator, Power Output Vs Frequency, Power Output Vs 

Bias Voltage.  

3. Measurement of frequency and Guide wavelength calculation: a. Verification of the 

relation between Guide wavelength, free space wavelength and cut-off Wavelength of X- 

band rectangular waveguide.  

 

4. Measurement of low and high VSWRs: VSWR of different components like matched 

terminals, capacitive and inductive windows, slide screw tuner for different heights of the 

tuning posts etc.  

5. Measurement of impedance for horn antenna, Matched load and slide screw tuner. 

6. To find the S-parameters of Directional coupler. 

 

                                        PART - B 

 

     1. To find the S-parameters of Tees: E plane, H plane and Magic Tee. 

     2. To find the S-parameters of Circulator 

     3. Measurement of radiation patterns for basic microwave antennas like horn and 

         parabolic reflectors in E-plane and H-plane. Also to finding the gain, bandwidth and 

         beamwidth these antennas.  

    4. How to Create, Simulate and Analyse the Dipole Antenna Structure by using EM 

            simulation software 

    5.   How to Create, Simulate and Analyse a Microstrip Rectangular Patch Antenna by  

            using EM simulation software 

    6.How to Create, Simulate and Analyse a Probe Feed Patch Antenna by using EM  

simulation software  

 

Note: At least 10 experiments to be carried out during the semester 

 

            Suggested Readings:  

1. Paul B. Zbar, Albert P. Malvino, Micheal A. Miller, Basic Electronics, A text – Lab 

Manual, 7th Edition, TMH 2001. . 
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4 VSWR measurement 26 
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PART- B 

7.a S - matrix characterization of E-plane Tee, H-

plane Tee 

38 

7.b S – matrix characterization of Magic Tee 42 

8 S-parameters of Circulator 45 

II Introduction to HFSS 48 

9 Design and simulate a Half wave dipole antenna 87 

10 Design and simulation of microwave patch 

antenna at 2.4ghz 

91 

BEYOND SYLLABUS 

11 To study the phase shifter 
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I. INTRODUCTION TO MICROWAVE COMPONENTS 

RECTANGULAR WAVE GUIDE  

Wave guides are manufactured to the highest mechanical and electrical standards and 

mechanical tolerances. L and S band wave guides are fabricated by precision brazing of 

brass-plates and all other wave guides are in extrusion quality. W.G. sections of specified 

length can be supplied with flanges, painted outside and silver or gold plated in side.  

 

SPECIFICATIONS 

EIA No. : WR - 90  

X Band frequency: 8.2 - 12.4 GHZ                        

Waveguide slot width: 2.286cm       Waveguide slot Height: 1.1016cm    

Total Component width: 2.54 cm       Total Component height: 1.27cm                   

Material: Brass/Copper. 

 

FIXED ATTENUATORS  

Series 5000 fixed Attenuators are meant for inserting a known attenuation in a wave guide 

system. These consist of a lossy vane inserted in a section of wave guide, flanged on both 

ends. These are useful for isolation of wave guide circuits, padding and extending the range 

of measuring equipments.  

Fixed Attenuators are available for 3, 6 or 10 dB attenuation values, but any attenuation valve 

between 0 and 30dB can be provided.  
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SPECIFICATIONS  

Model No: X-5000  

Frequency : 8.12 - 12.4 GHZ  

Attenuation (dB) : 3,6,10 

Calibration Accuracy : ± 0.2dB 

Avg Power : 2W/Max  VSWR : 1.10 Max Insertion Loss (dB) : 0.2/W.G.  

Type: WG – 90 / Flange Type (UG/U) : 39.  

A precision built probe carriage has a centimeter scale with a vernier reading of 0.1mm least 

count and a dial gauge can be mounted easily if precise readings are required.  

Model No. : X - 6051  

Freq (Ghz) : 8.2 - 12.4  Max Residual VSWR : 1.01  

WG type (WR-) : 90  Flange Type (UG-/U) : 39  

TUNABLE PROBE  

Model 6055 Tunable probe is designed for use with model 6051 slotted sections. These are 

meant for exploring the energy of the EF in a suitably fabricated section of wave guide.  

The depth of penetration into a wave guide - section is adjustable by the knob of the probe. 

The tip pick up the RF power from the line and this power is rectified by crystal detector, 

which is then fed to the VSWR meter or indicating instrument.  
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Model No. : X6055          Freq (Ghz) : 8.2 - 12.4  

output Connector : BNC(F)    Detector : IN23.  

WAVEGUIDE DETECTOR 
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MOUNT (TUNABLE) 

Model 4051 Tunable Detector Mount is simple and easy to use instrument for detecting 

microwave power through suitable detector. It consists of a detector crystal mounted in a 

section of a Wave guide and shorting plunger for matching purpose. The output from the 

crystal may be fed to an indicating instrument. In K and R bands detector mounts the plunger 

is driven by a micrometer.  

Model No. : X - 4051                        Freq. Range (Ghz) : 8.2 - 12.4  

O/P Connector : BNC (F)                 Wave guide type (WR-) : 90  

Flange Type (UG/U) : 39                   Detector : IN23  

KLYSTRON MOUNT  

Model 2051 Klystron mounts are meant for mounting corresponding Klystrons such as 2K25, 

723A/B, 726A or RK - 5976 etc. These consists of a section of wave guide flanged on one 

end and terminatedwith a movable short on the other end. An octalbase with cable is provided 

for Klystron. 
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KLYSTRON MOUNT 

 

 

Klyston tube 

Model No. : X – 2051                   Freq. Range (GHz) 8.2 - 12.4 

WG Type (WR-) : 90                    Flange Type (UG-/U): 39  

CIRCULATORS  

Model 6021 and 6022 are T and Y types of three port circulators respectively. These are 

precisely machined and assembled to get the desired specifications. Circulators are matched 

three port devices and these are meant for allowing Microwave energy to flow in clockwise 

direction with negligible loss but almost no transmission in the anti-clockwise direction.  

 

T type and Y type Circulator 

Model No. : X - 6021             Frequency Range (Ghz) : 8.6 - 10.6 or 10.2 - 12.2  

Min. Isolation (dB) : 20           Max. Insertion Loss (dB) : 0.4  

Max. VSWR : 1.20  
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SLIDE SCREW TUNERS  

Model 4041 slide screw tuners are used for matching purposes by changing the penetration 

and position of a screw in the slot provided in the centre of the wave guide.  

These consists of a section of wave guide flanged on both ends and a thin slot is provided in 

the broad wall of the Wave guide. A carriage carrying the screw, is provided over the slot. A 

VSWR upto 20 can be tuned to a value less than 1.02 at certain frequency.  

 

Model No. : X – 4041                          Freq. Range (Ghz) : 8.2 - 12.4 

WG Type (WR-) : 90                           Flange type (UG/U) : 39  

MULTIHOLE DIRECTIONAL COUPLERS  

Model 6000 series Multi hole directional couplers are useful for sampling a part of 

Microwave energy for monitoring purposes and for measuring reflections and impedance. 

These consist of a section of Wave guide with addition of a second parallel section of wave 

guide thus making it a four port network. However the fourth port is terminated with a 

matched load. These two parallel sections are coupled to each other through many holes, 

almost to give uniform coupling; minimum frequency sensitivity and high directivity. These 

are available in 3, 6, 10, 20 and 40dB coupling.  
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Model No. : X - 6003                             Frequency Range (Ghz) : 8.2 - 12.4  

Coupling (dB) : 3,10,20,40                    Directivity (dB) : 35  

Wave guide type (WR-): 90                   Flange type (UG/U) : 39  

E PLANE TEE  

Model 3061 E - plane tee are series type T - junction and consists of three section of wave 

guide joined together in order to divide or compare power levels. The signal entering the first 

port of this T - junction will be equally dividing at second and third ports of the same 

magnitude but in opp. Phase 

 

 

 

 

Model No. : X - 3061        Frequency Range (GHz) : 8.2 - 12.4  

WG Type (WR-) : 90         Flange Type (UG/U) : 39  
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H - PLANE TEE  

Model 3065 H - Plane Tee are shunt type T - junction for use in conjunction with VSWR 

meters, frequency - meters and other detector devices. Like in E-plane tee, the signal fed 

through first port of H - plane Tee will be equally divided in magnitude at second and third 

ports but in same phase.  

 

Model No. : X - 3065                Frequency Range (GHz) : 8.2 - 12.4  

WG Type (WR-) : 90                  Flange Type (UG-/U) : 39  

MAGIC TEE  

Model 3045 E - H Tee consists of a section of wave guide in both series and shunt wave 

guide arms, mounted at the exact midpoint of main arm. Both ends of the section of wave 

guide and both arms are flanged on their ends. These Tees are employed in balanced mixers, 

AFC circuits and impedance measurement circuits etc. This becomes a four terminal device 

where one terminal is isolated from the input terminal.  
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Model No. : X - 3045              Frequency Range (GHz): 8.2 - 12.4  

WG Type (WR-) : 90               Flange Type (UR-/U) : 39  

MOVABLE SHORT  

Model 4081 movable shorts consists of a section of waveguide, flanged on one end and 

terminated with a movable shorting plunger on the other end. By means of this non 

contacting type plunger, a reflection co-efficient of almost unity may be obtained.  

 

 

 

Model No. : X - 4081       Frequency Range (GHz) : 8.2 - 12.4  

WG Type (WR-) : 90        Flange Type (UG-/U) : 39  

MATCHED TERMINATION  
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Model 4000 are low power and non-reflective type of terminations. It consists of a small and 

highly dissipative taper flap mounted inside the centre of a section of wave guide. Matched 

Terminations are useful for USWR measurement of various waveguide components. These 

are also employed as dummy and as a precise reference loads with Tee junctions, directional 

couplers and other similar dividing devices.  

Model No. : X - 4000, Freq. Range (GHz) : 8.2 - 12.4 Max VSWR : 1.04  

AV Power: 2W, WG Type (WR-) 90, Flange Type (UG-/U) : 39  

PYRAMIDAL WAVEGUIDE HORN ANTENNA  

Model 5041 pyramidal Wave guide Horn antenna consists of waveguide joined to pyramidal 

section fabricated from brass sheet. The pyramidal section shapes the energy to concentrate in 

a specified beam. Wave guide horns are used as feed horns as radiators for reflectors and 

lenses and as a pickup antenna for receiving microwave power.  

 

 

Model No. : X - 5041    Frequency Range (GHz) : 8.2 - 12.4  

Max VSWR: 1.20        WG Type (WR-) : 90  

Flange Type (UG-/U) : 39  

GUNN OSCILLATORS  

Model 2151 Gunn Oscillators are solid state microwave energy generators. These consist of 

waveguide cavity flanged on one end and micrometer driven plunger fitted on the other end. 

A Gunn-diode is mounted inside the Wave guide with BNC (F) connector for DC bias. Each 
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Gunn oscillator is supplied with calibration certificate giving frequency vs micrometer 

reading.  

 

 

Model No. : X – 2152                     Freq : 8.2 - 12.4 GHz 

Min output power: 10 MW     WG Type (WR-) : 90 Flange Type (UG-/U) : 39  

PIN MODULATORS  

Model 451 pin modulators are designed to modulate the cw output of Gunn Oscillators. It is 

operated by the square pulses derived from the UHF (F) connector of the Gunn power supply. 

These consists of a pin diode mounted inside a section of Wave guide flanged on it’s both 

end. A fixed attenuation vane is mounted inside at the input to protect the oscillator.             

 

 

 

Model No. : X - 451                      Frequency Range (GHz) : 8.3 - 12.4  
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Max RF Power: 1W              WG Type (WR-) : 90 Flange Type (GHz) : 39  

 

 

GUNN POWER SUPPLY  

Model X-110 Gunn Power supply comprises of an regulated DC power supply and a square 

wave generator, designed to operate Gunn-Oscillator model 2151 or 2152, and pin 

modulators model 451 respectively. The DC voltage is variable from 0 - 10V. The front panel 

meter monitors the Gunn voltage and the current drawn by the Gunn diode. The square wave 

of generator is variable from 0 - 10V. in amplitude and 900 - 1100 Hz in frequency. The 

power supply has been so designed to protect Gunn diode from reverse voltage application 

over transient and low frequency oscillations by the negative resistance of the Gunn-diode.  

 

 

 control : ‘Coarse’  

ISOLATORS  

The three port circulators Model 6021 may be converted into isolators by terminating one of 

its port into matched load. These will work over the frequency range of circulators. These are 

well matched devices offering low forward insertion loss and high reverse isolation.  

 

Model No. : X - 6022         Frequency Range (GHz) : 8.6 -  12.2  
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Min Isolation (dB): 20       Max Insertion Loss (dB) : 0.4 Max VSWR : 1.20 . 

Thus all the microwave components were studied in detail.  

 

REVIEW QUESTIONS  

1. What is microwave?  

2. Mention the frequency band for a millimetre wave.  

3. List some of IEEE microwave frequency bands.  

4. List some of characteristic feature of microwave.  

5. List some of the application of microwave technology.  

6. Draw a simple microwave system.  

7. What are waveguide `Tees’?  

8. List the basic type of waveguide tees.  

9. What is an isolator?  

10. What is a circulator?  

11. What is a directional coupler?  

12. What is velocity modulation?  

13. Mention the Principle used in Klystron?  

14. When the o/p power of reflex klystron maximum?  

15. What is meant by attenuator?  
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1. MODE CHARACTERISTICS OF REFLEX KLYSTRON  

 

AIM: To study the Mode Characteristics of Reflex Klystron. 

 

APPARATUS REQUIRED:  

 

Klystron Power Supply, Klystron with mount, Isolator, Frequency meter, Variable 

Attenuator, Slotted section with Probe carriage, CRO, Movable Short.  

 

THEORY: 

 

Klystron is a microwave vacuum tube employing velocity modulation. These electrons move 

towards the repeller (ie) the electrons leaving the cavity during the positive half cycle are 

accelerated while those during negative half cycle are decelerated. The faster ones penetrate 

further while slower ones penetrate lesser in the field of repeller voltage. But, faster electrons 

leaving the cavity take longer time to return and hence catch up with slower ones. In the 

cavity the electrons bunch and intract with the voltage between the cavity grids. It consists of 

an electron gun producing a collimated electron beam. It bunches pass through grids at time 

the grid potentials is such that electrons are decelerated they give by energy. The electrons 

are then collected by positive cavity wall near cathode. To protect repeller from damage, 

repeller voltage is applied before accelerating voltage.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig: Set up for Klystron Tube Characteristics 

 

PROCEDURE:  

 

1) Assemble the components as shown in fig.  

2) After following the necessary precautions, the Klystron Power Supply is switched ON.  

3) To obtain peak voltage, the attenuator is positioned at it’s minimum attenuation.  

4) Vary the repeller voltage from it’s maximum negative value and increase it in steps on N 

and record output power and frequency. 

5) The frequency is measured by tuning the basic frequency meter to have a dip in the output 

voltage each time. 

6) The frequency meter is detuned before measuring the output power each time.  

Klystron 

Power 

Supply 

Frequency 

Meter 

Variable 

Attenuator 

 

Isolator 

Reflex 

Klystron 

Oscillator 

Wave guide 

Detector 

Mount 

Output 

Meter 

(CRO) 
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7) The mode characteristics of Reflex Klystron is plotted. (i.e. Output Voltage Vs Repeller 

voltage and Frequency Vs Repeller voltage)  

 

BASIC PRECAUTIONS: 

1) During operation of Klystron, repeller does not carry any current and as such it may 

severely be damaged by electron bombardment. To protect repeller from such damage, the 

repeller negative voltage is always applied before anode voltage.  

2) The repeller voltage should be varied in one direction to avoid hysteresis in klystrons . 

3) The heater voltage should be applied first and cooling should be provided simultaneously 

after some time other voltages should be applied taking precaution 

4) While measuring power, the frequency meter should be detained each time because there 

is a dip in the output power when the frequency is tuned.  

5) To avoid loading of the klystron an isolator/attenuation should invariably be used between 

klystron and the rest of the set-up.  

CALCULATIONS:  

(i)  ETR – Electronic tuning range i.e, the frequency band from one end of the mode to 

another is calculated by  

ETR = f1max – f1min for N1 mode (GHz)  

      f1max, f1min → half power frequencies  

(ii) ETS – Electronic tuning sensitivity  

ETS = = f1max – f1min/V1max- V1min (MHz/V)  

f1max, f1min → half power frequency  

V1max, V1min→ corresponding repeller voltages for a particular mode. 

(iii)Knowing mode top voltages of two adjacent modes, mode numbers of the modes is 

computed from the equation,  

 

N2/ N1= V1/ V2= (n+1) +3/4/n+3/4 

                          OR 

N2/ N1= V1/ V2= (n+1.75)/(n+0.75) 

               Where V1 and V2 are the values of repeller voltages required to operate the klystron 

in mode numbers N1 and N2.  

(iv) Transit time of each mode is calculated from  

              

t1 = (n+3/4)/f1= N1/f1 

              Where f1=frequency of microwave operation in one mode. 
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TABULAR COLUMN: 

1) Table 1 

Repeller Voltage((VR)     Output Voltage(V) 

  

 

 

 

 

 

 

 

2) Table 2 

Beam Voltage=_ _ _ _ _ _ _ _ _ _               Beam Current=_ _ _ _ _ _ _ _ _ _ 

S.NO Mode Repeller Voltage(VR) Output 

Voltage (V) 

Frequency(GHz) 
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EXPECTED GRAPH: 

 

  RESULT: The characteristics of Klystron Oscillator are verified and modes are calculated. 

 

REVIEW QUESTIONS  

1. List two basic configurations of Klystron tubes.  

2. What is velocity modulation?  

3. List down the characteristic of two cavity klystron amplifier.  

4. Write a note on mode of oscillations.  

5. Draw the reflex klystron modes.  

6. Higher order mode occurs at ____________ repeller voltage.  

7. When the o/p power of reflex klystron maximum?  

8. List the application of reflex klystron.  

9. What is transit time?  
10. Which mode number is most frequently used? Why? 
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2. STUDY OF VI CHARACTERISTICS OF GUNN DIODE 

AIM: Study of VI characteristics of Gunn diode. 

APPARATUS: 

X-Band Gunn Oscillator, Microwave bench, PIN modulator, Isolator, Frequency meter, 

Variable attenuator, Slotted section, Tunable probe, Detector  Mount, Matched termination, 

Gunn power supply, Wave guide stand, BNC cable, 

Cooling fan. 

 

 

 

 

 

 

 

Fig: Bench Set up Diagram 

THEORY: 

Some bulk semiconductor materials such as Gallium arsenide (GA As), Indium phosphide 

(InP) and Cadmium Telluride (CdTe) have two closely spaced energy bands in the 

conduction band. At lower electric field strengths in the material, most of the electrons will 

be transmitted into higher energy band. In the higher energy band the effective electron mass 

is longer and hence the electron mobility is lower than what it is in the lower energy band. 

Since the conductivity is directly proportional to the mobility there is an immediate range of 

electric field strengths for which the fraction of electrons that are transferred into higher 

energy low mobility conduction is such that the average mobility and hence conductivity 

decreases with an increase in the electric field strength. Thus there is a range of voltage over 

which the current decreases with the increasing voltage and a negative instrumental of 

resistance is displayed by the device. A Gunn device is also called a transferred electronic 

device since the negative resistance arises from the transfer of electrons from the lower to 

higher energy band. The oscillations that occur in the material with energy band structure 

noted above was discovered by J.B.GUNN. The probability of obtaining negative differential 

resistance had been predicted earlier by Ridley and Watkins. 

PROCEDURE; 

1. First connect the Gunn test bench as shown in block diagram.  

Output 

meter 

Gunn 

Power 

Supply 

  

Gunn 

Oscillator 
Wave 

guide 

Detector 

Frequency 

Meter 

Variable 

Attenuato

r 

Isolator 
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2.  Keep the control knobs of power supply as detailed below:  

 

ON/OFF switch  :  OFF  

Gunn diode bias knob : fully anti-clockwise to keep the bias voltage to  

                                        zero to start with.  

PIN bias knob  :  fully anti-clockwise to keep the bias voltage to zero to start 

with  

PIN mode frequency   : middle position to keep frequency approx. to 1 kHz.  

3. Do not apply any bias to PIN diode throughout the experiment.  

4. Set the micrometer on the wave guide cavity Gunn oscillator to approximately 10.9mm 

(approximate 9.5GHz) 

5. Increase the voltage in steps of 0.5V up to l0V and record the corresponding current from 

the meter on the Gunn power supply by switching alternately to current and voltage position. 

6. Reset the Gunn power supply and at each bias voltage tune the frequency meter to observe 

the dip. Note the frequency reading. 

7. Reset the Gunn power supply and vary the micrometer of the Gunn oscillator and observe 

the dip in CRO. 

8. Note down the micrometer reading of the Gunn and corresponding frequency from 

frequency meter. 

9. Draw the following graphs between a) V-I characteristics as observed in the power supply 

panel (b) Bias voltage Vs Frequency (c) Frequency & micrometer reading of Gunn. 

 

TABULAR COLUMN: 

S.No Voltage 

(Volts) 

Current (mA) Frequency (GHz) 
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EXPECTED GRAPHS: 

             

          

  

                                                                                           

 

RESULT: The Characteristics of Gunn diode are verified and plotted 

 

 

REVIEW QUESTIONS  

 

 

1. What is Gunn effect? 

2.  GaAs is used in the fabrication of GUNN diodes because....................... 

3.  The gunn diode is................................. 

4.  When the applied electric field exceeds the threshold value, electrons absorb more energy 

from the field and become.............................. 

5.  The electrodes of a Gunn diode are made of........................... 

6. When either a voltage or current is applied to the terminals of bulk solid state compound 

GaAs, a differential ______ is developed in that bulk device. 

7.  The frequency of oscillation in Gunn diode is given by................................. 
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8. The modes of operation of a Gunn diode are illustrated in a plot of voltage applied to the 

Gunn diode v/s frequency of operation of Gunn diode. 

a) true 

b) false 

9. The Gunn diode is used in the range of....................... 

10. Silicon and germanium are called ___________ semiconductors. 

11. What is the another name of Gunn diode? 

12. Draw the equivalent Circuit for GUNN?  

13. What are the different modes in GUNN diode oscillator? 

14. How many junctions are there in GUNN? 

15. Explain the transferred electron effect in GUNN?  

16. What are applications of GUNN? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



METHODIST COLLEGE OF ENGINEERING AND TECHN0LOGY 

 

23 | P a g e  
BE CBCS VII SEM MW LAB MANUAL (E&CE) 
 

 

3. WAVELENGTH & FREQUENCY MEASUREMENT 

AIM: To determine the guide wavelength of rectangular wave guide in a dominant mode               

propagation. 

COMPONENTS REQUIRED: 

1. Microwave source  (klystron power supply) 
 

2. Klystron Mount 
 

3. Isolator 
 

4. Variable Attenuator 
 

5. Frequency meter 
 

6. Slotted section 
 

6. Matched Termination 
 

7. VSWR meter (or) CRO 

 

     BLOCK DIAGRAM: 

 

 

 

PROCEDURE: 

1. Arrange the bench setup as shown in figure. 

2. Switch on the microwave source and adjust the attenuator, frequency meter, 

etc to get maximum power. 

3. Move the carriage probe in the slotted section in particular direction until 

there is a minimum deflection in the indicating meter is obtained note this 

distance as d1. 
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4. Once again move the carriage probe from its position d1 in particular 

direction in order to get minimum deflection on the indication meter. Note 

this distance as d2. 

5. Calculate the guide wave length using formula, also find frequency of the 

wave using formula and verify it with frequency meter. 

 

OBSERVATIONS AND CALCULATIONS: 

        I) USING DETECTOR MOUNT AT THE LOAD 

                         Beam Voltage     = _________                   Beam Current = _______ 

                         Repeller Voltage = _________                   Dip Frequency= ________ 

       II) USING SLOTTED SECTION WITH MATCHED TERMINATION: 

 Guide wavelength (λg) = 2(d2 ~ d1) 

                Where d1 , d2 are two successive minimums (or) maximum. 

Cut-off wavelength ( λc) =2a, 
 

             a = 22 .86mm for X band. 

  Free space wavelength (λo) by using 

         1/ λo 2 = 1/ λg2+1/ λc2 

  Frequency (f) = C/ λo 

 

 

 

RESULT: Thus the wavelength & frequency of the wave is determined. 

 

 

REVIEW QUESTIONS  

 

1) How are wavelength measured?  

2) How do you measure wavelength in a compression wave?  

3) What are the units of measure for wavelength? 

4) What is frequency and how is it measured? 

5) How is a sound's frequency measured?  
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6) What is the frequency of waves measure in? 

7) What is the cut off wave length? 

8) What is the dominant mode of rectangular waveguide? Explain. 

9) Indicate the frequency Vs wave length for X-band?  

10) Explain the principle of frequency meter? 

11) What type of frequency meter used in microwave test bench?  

12) What is the microwave frequency range? 
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4. VSWR MEASUREMENT 

AIM: To determine the standing wave ratio and reflection coefficient. 

EQUIPMENTS: 

       1. Klystron tube   2. Klystron power supply  3. VSWR meter   4. Klystron Mount 

       5. Isolator     6. Frequency meter    7. Variable attenuator    8. Slotted line 

       9. Tunable probe   10. Wave guide stand   11. S-S tuner     12. Movable short 13. BNC 

Cable 

THEORY: 

The electromagnetic field at any point of transmission line, may be considered 

as a travelling waves: ‘Incident Wave’ propagates from generator and the reflected wave 

propagates towards the generator. The reflected wave is set up by reflection of incident wave 

from a discontinuity on the line or from the load impedance. The magnitude and phase of 

reflected wave depends upon amplitude and phase of the reflecting impedance. The presence 

of two travelling waves, gives rise to standing wave along with the line. The maximum field 

strength is found where two waves are in phase and minimum where the two waves adds in 

opposite phase. The distance between two successive minimum (or maximum) is half the 

guide wave – length on the line. The ratio of electrical field strength of reflected and incident 

wave is called reflection coefficient. The voltage standing ratio (VSWR) is defined as ratio 

between maximum and minimum field strength along the line. 

 Hence VSWR, S= Emax/Emin = (|Ei|+|Er|)/ (|Ei| -|Er| ) 

 Reflection Coefficient, ρ =Er/Ei = {Z – Zo}/ {Z + Zo} 

  Where Z is the impedance at a point on line, Zo is characteristic impedance. 

The above equation gives following equation: 

                   |ρ| = [S-1]/[S+1] 

BLOCK DIAGRAM: 

 

 

PROCEDURE: 
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I. GENERAL: 

1. The equipments is set as shown in block diagram. 

2. The variable attenuator is set to maximum position. 

3. The control knobs of VSWR meter is set as below: 

  a. Range db – 40db/50db position 

  b. Input Switch – Crystal low impedance 

  c. Meter Switch – Normal position 

  d. Gain (Coarse and fine) – Mid position 

4. The control knobs of klystron power supply is set as below: 

  Meter switch – ‘OFF’ 

   Mod – switch – AM 

  Beam voltage knob – fully anticlockwise 

   Reflector voltage – fully clockwise. 

  AM amplitude knob – around fully clock wise. 

  AM frequency knob – around mid position. 

5. The klystron power supply, VSWR meter and cooling fan are switched on. 

6. The meter switch of power supply is turned to beam voltage position and beam voltage is 

set to 300V with help of beam voltage knob. 

7. The reflector voltage is adjusted to get some deflection in VSWR meter. 

8. The output is tuned by tuning reflector voltage, AM amplitude and frequency control knob 

of power supply. 

9. The plunger of klystron mount is tuned for maximum deflection. 

10. The probe is also tuned for maximum deflection in VSWR meter. 

11. To get deflection in the scale of VSWR the range db – switch, variable attenuator position 

and gain control knob is adjusted if necessary. 

12. The deflection in VSWR can be varied by moving the probe along the slotted line. 

 

II. MEASUREMENT OF LOW AND MEDIUM VSWR: 

1. The probe is moved along the slotted line to get maximum deflection in VSWR meter. 

2. VSWR meter gain control knob or variable attenuator is adjusted until the meter indicates 

1.0 on the normal upper SWR scale. 
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3. The probe is moved to next minima point without disturbing all the control knobs and 

corresponding VSWR is recorded. 

4. The above step is repeated for change of S-S tuner probe depth and corresponding VSWR 

is recorded. 

5. If the VSWR is between 3.2 and 10, then range dB switch is changed to next higher 

position and VSWR is read from this second scale ranging from 3 t0 10. 

III. MEASUREMENT OF HIGH VSWR (Double Minimum Method): 

1. The depth of S-S tuner is set slightly more for maximum deflection. 

2. The probe is moved along the slotted line till a minimum is indicated. 

3. The VSWR meter gain control knob and variable attenuator is adjusted to obtain a reading 

of 3db of normal db of VSWR Meter. 

4. The probe is moved to the left on slotted line, until full scale deflection is obtained, i.e. 0db 

on 0-10db scale. The corresponding probe position is noted. Let it be d1. 

5. The step 3 and 4 are repeated and then the probe is moved to right along with slotted line 

until full scale deflection is obtained on 0- 10 db normal db scale. Let it be d2. 

6. The S-S tuner and terminator is replaced by movable short. 

7. The distance between two successive minima position of probe is measured. Twice this 

distance gives guide wavelength λg. 

8. VSWR is computed by following equation:  S = λg/[ π(d1-d2)]. 

OBSERVATIONS: 

With S-S tuner and Termination: 

 First minima position d1 = ____________________cm. 

 Second minima position d2 = ____________________cm. 

With Movable Short: 

 First minima position d3 = ____________________cm. 

 Second minima position d4 = ____________________cm. 

 Guide wavelength, λg = 2(d3-d4) = ____________________cm 

VSWR is computed as follows: 

 VSWR = λg/π(d1-d2) =____________________. 
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RESULT: 

 Thus The VSWR is measured. 

 Measured value of VSWR = _______________. 

 

Viva Questions 

1) Does VSWR vary with line length?  

2) Can the magnitude of the reflection coefficient (ρ) be greater than 1? 

3) Can VSWR be negative?  

4) Is there a the minimum length of transmission line required on either side of the VSWR 

meter for valid readings?  

5) Is the characteristic impedance of the sampler line section important? 

6) What is standing wave?  

7) What is reflection coefficient?  

8) When do standing waves form?  

9) How they are useful in microwave engineering?  

10) What is min. value of VSWR?  

11) What is range of reflection coefficient? 
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5. RADIATION PATTERN OF HORN ANTENNA 

AIM: To obtain directional pattern of a Horn Antenna. 

APPARATUS REQUIRED 

Klystron Power Supply, Klystron with mount, Isolator, Frequency meter, Fixed  

Attenuator Detector, Parabolic Reflector, CRO. 

 

 

 

 

 

 

 

 

 

THEORY 

A horn antenna may be regarded as a flared out or opened out wave guide. A wave 

guide is capable of radiating radiation into open space provided the same is excited at one 

end and opened at the other end. However, the radiation is much greater through wave 

guide than the 2 wire transmission line. To overcome reflection and diffraction in the wave 

guide, the mouth of the waveguide is opened out which assumes the shape of a 

electromagnetic horn. If the wave guide is terminated by any type of horn, the abrupt 

discontinuity existed is replaced by a gradual transformation, then all the energy incident 

in forward direction in the waveguide will now be radiated, provided the impedance 

matching is proper. This improves directivity and reduces diffraction. If flaring is done 

only in one direction, then sartorial horn is produced. If flaring is done along both the 

walls, then pyramidal horn is obtained. By flaring the walls of the circular waveguide, a 

conical horn is formed. The fields inside the waveguide propagate in the same manner as 

in free space, but on reaching the mouth of the waveguide, these propagating fields 

continue to propagate in the same general direction but also starts spreading laterally and 

the wave front eventually becomes spherical. However this may be treated as transition 

region where the change over from the guided propagation to free space propagation 

occurs. Since the waveguide impedance & free space impedance are not equal, hence to 

avoid standing wave ratio, flaring of walls of waveguide is done which besides matching 

of impedance also provide concentrated radiation pattern (ie) greater directivity and 

narrower beam width. It is the flared structure that is given the name electromagnetic horn 

radiator. The function is to produce a uniform phase front with a larger aperture in 
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comparison to waveguide and thus directivity is greater. If flare angle is very large, the 

wave front on the mouth of the horn will be curved rather than plane. This will result in 

non-uniform phase distribution over the aperture, resulting in increased beam width and 

reduced directivity, and vice versa occurs if the flare angle is very small. The directivity of 

the horn antenna is given as D = 7.5 A/λ2 where A area of horn mouth opening. Horn 

antennas are extensively used at microwave frequencies under the condition that power 

gain needed is moderate. 

Precaution-Power flowing out of horns may damage retina of the eye so do not see 

directly inside the horn antenna 
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INPUT VOLTAGE VT = 330mv 
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PROCEDURE 

1. Setup the equipments as shown in fig. Keeping the axis of both antennas in same axis line 

2. Energize the microwave source, and set mode 3 determines input power at transmitting 

antenna end by connecting detector mount. 

3. Connect the transmitting antenna back. Turn the receiving horn to the left in 5° steps upto 

at least 60° and note the corresponding voltage. 

4. Repeat the above step but this time turning the receiver to the right and note down the 

readings. 

5. Draw a relative power pattern ie, o/p vs angle. 

6. From diagram 3 dB beam width is determined. 
 

RESULT 

Thus the directional pattern of the Horn antenna was obtained and the corresponding 

graph was drawn. 

 Viva Questions 

 1) What is horn? 

 2) In order to function properly, a horn antenna must be a certain minimum size .What is it?  

3) Where are Horn antennas commonly used ? 

4)-------- is basic building block for any practical antenna 

5) Which is a non-resonant antenna? 

6)______ is the measurement of a unilateral antenna properties of directivity 

7) Top loading is used in an antenna in order to increase its ______. 

8) All elements in a beam _____ antennas are in line 

 9) Which antenna with very high gain and very narrow beamwidth. 

10)_____ is the horizontal pointing angle of an antenna 

 



METHODIST COLLEGE OF ENGINEERING AND TECHN0LOGY 

 

34 | P a g e  
BE CBCS VII SEM MW LAB MANUAL (E&CE) 
 

 

6. DIRECTIONAL COUPLER 

AIM : To study the function of multi hole directional coupler by measuring the following 

parameters. 

1. Coupling factor          2. Insertion loss         3. Directivity         4. Isolation Loss 

 

APPARATUS: 

Microwave source (Klystron or Gunn diode), Isolator, Frequency meter, Variable attenuator, 

Slotted line, Tunable probe, Detector mount, Matched termination, MHD coupler, 

Waveguide Stand, Cables and Accessories, VSWR meter/CRO.  

 

 

 

 

THEORY: 

A directional coupler is a useful hybrid waveguide joint, which coules power in an auxiliary 

waveguide arm in one direction. It is a four-port device but one of the ports is terminated into 

a matched load. Ref figure 1.  

 

Characteristics of a Directional Coupler  
An ideal directional coupler has the following characteristics  
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 i) If power is fed into port (1) the power is coupled in ports (2) and (3) i.e., power 

flows   in the forward direction of the auxiliary arm port (3) but no power couples 

in port (4)   i.e., in backward direction similarly power fed in (2) couples into 

ports (1) and (4) and   not in (3).  

 ii)  All the four ports are matched, i.e. if three of them are terminated in matched 

loads, the fourth is automatically terminated in a matched load.  

      iii) If power couples in reverse direction, power fed in (1) appears in ports (2) and   

      nothing in (3), then such type of coupler is known as backward directional 

coupler.    

      The conclusion is that in the auxiliary section the power is coupled in only one 

      Direction.  

 

PROCEDURE:  

 

1. Connect the components and equipment as shown in fig. 2 

2. Keep the control knob of klystron power supply as below: 

 Modulation selection: AM 

 Beam voltage knob: Fully anti-clockwise 

 Reflector voltage knob: Fully clockwise 

 Selector switch: Beam voltage 

3. Keep the AM modulation control knob of amplitude &frequency at mid position. 

4. Switch on the klystron power supply. 

5. Now vary the Beam voltage knob to 280 V. Next change the selector knob to Beam 

Current. Observe the BEAM CURRENT. [The beam current should not be more 

than 20 mA]. 

6. Now change the selector switch to Reflector voltage position. 

7. Now decrease the Reflector voltage to minimum position. 

8. Now observe the square wave form in CRO by varying either reflector voltage or 

adjusting the amplitude knob of AM. 

9. Set the equipment by connecting detector mount to the input end (without directional 

coupler),  

now measure the input Power(P1) i.e. Pi. Do not alter till the end of the experiment.  

10. Now Insert the directional coupler connect the detector mount at port2, Terminate the 

port4 with matched termination. Now measure the Power at port 2 i.e. P2 or Pr(received 

power).. 

11. Then connect detector mount to port 4 terminate port 2 with matched termination. Now 

measures the power at port 4 i.e. P4 or Pf (forward power). 
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12. Connect the directional coupler in reverse direction. ie, port 2 – input, port 1 – matched 

termination, port 3 – detector mount. Now measure the power at port 3 i.e. P3 or Pb 

(backward power) 

 

CALCULATIONS: 

 

1) Coupling Factor (C) = 10 log (pi/pf) db=20 log (Vi/Vf) db 

2) Directivity (D)= 10 log (pf/pb) db = 20 log (Vf/Vb) db 

3) Isolation (I) =10 log (pi/pb) db = 20 log (Vi/Vb) db 

4) Insertion loss (L)=10 log (pi/pr) db = 20 log (Vi/Vr) db 

 

RESULT:   The performance characteristics of directional coupler were determined. 

 

 

Viva Questions 

 1) What is the primary purpose of a directional coupler? 

2) How far apart are the two holes in a simple directional coupler? 

3) What is the purpose of the absorbent material in a directional coupler?  

 

4) In a directional coupler that is designed to sample the incident energy, what happens to the 

two portions of  the wave front when they arrive at the pickup probe?  

 

5) What happens to reflected energy that enters a directional coupler that is designed to sample 

incident energy? 

 

6) What is directional coupler?  

 

7) How many ports does it have?  

 

8) What is the difference between dc to magic tee?  

 

9) What is Directivity?  

 

10) What is Insertion Loss?  

 

11) What is Coupling Factor?  

 

12) What is the relation between coupling factor and insertion loss? 
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PART B 
 

 

 

 

EXPERIMENTS 
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7. A) S - MATRIX CHARACTERIZATION OF E-Plane Tee and H-Plane Tee 

 

AIM: To Measure the power division in the E-Plane Tee, H-Plane Tee and Magic Tee. 

EQUIPMENTS REQUIRED: 

Klystron power supply  

Klystron Tube  

Klystron Mount  

Isolator  

Frequency Meter  

Variable Attenuator  

Slotted section  

Detector Mount  

Wave guide Stands  

VSWR Meter  

BNC Cable  

CRO  

H-Plane Tee  

E-Plane Tee 

 

GENERAL EXPERIMENTAL SETUP: 
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TABULATION: 

 

PORT1 PORT2 PORT 3 

   

   

 

 

E-PLANE TEE: 

 

PROCEDURE: 

1. Connect the components and equipment as shown in fig. 2 

2. Keep the control knob of klystron power supply as below: 
 

Modulation selection : AM 
 

Beam voltage knob : Fully anti-clockwise 
 

Reflector voltage knob : Fully clockwise 
 

Selector switch : Beam voltage 

3. Keep the AM modulation control knob of amplitude &frequency at mid 
     Position.    

4. Switch on the klystron power supply. 

5. Now vary the Beam voltage knob to 295V. Next change the selector knob to Beam 

    Current. Observe the BEAM CURRENT  
 

6. Now change the selector switch to Reflector voltage position. 
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7. Now decrease the Reflector voltage to minimum position. 

8. Now observe the square wave form in CRO by varying either reflector voltage or 

    adjusting the amplitude knob of AM.    

9. Connect the slotted section output to detector mount , now measure the power (or)  

     Voltage using CRO (or) power meter 

10. Now remove the detector mount from slotted section connect the H Plane Tee 

  Port1 to slotted section. Terminate the Port 3, with matched termination. 

       Now measure the power or voltage at Port 2 (P2) using CRO (or) power meter. 

11. Then remove the detector mount from Port 2, and connect to port 3, terminate the  

      Port 2, with matched termination. Now measure the power or voltage at Port 3(P3)             

      using CRO meter 

 

TABULATION: 

 

P1 dB P2 dB 

 

P3 dB 

 

   

   

 

 

 

 

 

 

RESULT: 
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Viva Questions 

1) What are the two basic types of T junctions?  

2) Why is the H-type T junction so named? 

 3) The magic-T is composed of what two basic types of T junctions? 

 4) What are the primary disadvantages of the magic-T?  

5) What type of junctions are formed where the arms of a hybrid ring meet the main ring?  

6) Hybrid rings are used primarily for what purpose? 
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7. B) S – MATRIX CHARACTERIZATION OF MAGIC TEE 
 

AIM: To Measure Isolation between E and Harms of the magic tee & Demonstrate 3dB 

Power Division in side arm the magic tee. 

EQUIPMENTS REQUIRED: 

♦ Klystron power supply  

♦ Klystron Tube  

♦ Klystron Mount  

♦ Isolator  

♦ Frequency Meter  

♦ Variable Attenuator  

♦ Slotted section  

♦ Detector Mount  

♦ Wave guide Stands  

♦ VSWR Meter  

♦ BNC Cable  

♦ CRO  

♦ Magic Tee 
 

EXPERIMENTAL SETUP: 
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PROCEDURE: 

1. Connect the components and equipment as shown in fig. 2 

2. Keep the control knob of klystron power supply as below:  

            Modulation selection : AM 
 

            Beam voltage knob : Fully anti-clockwise 
 

            Reflector voltage knob : Fully clockwise 
 

            Selector switch : Beam voltage 

3. Keep the AM modulation control knob of amplitude &frequency at   
          mid position. 

4. Switch on the klystron power supply. 
5. Now vary the Beam voltage knob to 295V. Next change the selector knob to Beam 
    Current. Observe the BEAM CURRENT. [The beam current should not be more than  
    30 m amps].            
6. Now change the selector switch to Reflector voltage position. 

7. Now decrease the Reflector voltage to minimum position. 
8. Now observe the square wave form in CRO by varying either reflector voltage or   
     adjusting the amplitude knob of AM.    
9. Connect the slotted section output to detector mount now measure the power from the 

    Detector mount P1 (or) voltage using CRO or power meter. Remove the detector mount 

     from the slotted section then connect the magic tee collinear arm 1 to slotted section 

     output connect the detector mount to collinear arm 2.             

10. Terminate the port 4 and port 3 with matched termination. Now measure the power or 

      Voltage at port 2 using CRO or power meter.     

11. Now remove the detector mount from the collinear arm 2 connect the detector  
 Mount to port 3 terminate the collinear arm 2 and port 4 with matched termination.  

 Now measure the power or voltage at port 3(P3) using CRO or power meter.   

12. Now remove the detector mount from the port3, and connect to port 4 then 
      terminate the collinear arm and port 3, with matched termination. Now measure 
      the power (or) voltage port (P4) using CRO or power meter. 

 

FORMULA: 
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RESULT: 

 

 

Viva Questions 

1) What are the two basic types of T junctions? 

2) Why is the H-type T junction so named? 

3) The magic-T is composed of what two basic types of T junctions? 

4) What are the primary disadvantages of the magic-T?  

5) What is magic tee?  

6) How many ports does it have?  

7) Difference between magic tee to directional coupler?  

8) What is magic behind this?  

9) A magic tee is nothing but a modification of..................... 

10) What are the applications of magic T 
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8. S-PARAMETERS OF CIRCULATOR 

AIM: To find the S-parameters and characteristics of circulator. 

EQUIPMENT: 

 1. Microwave source (klystron power supply)  

 2. Klystron Mount  

 3. Isolator  

 4. Variable Attenuator  

 5. Frequency meter  

 6. Circulator  

 7. Power Detector  

 8. Matched termination ----- 1 No  

TEST SETUP: 

 

 

 

 

 

 

 

Circulators: 

 

 

 

 

                                         

                                             Y – Type                              T – Type  
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                          S11         S12    S13                   0   0   1 

         [S]    = S21 S22    S23        =        1   0   0 

                                                       S31     S32           S33               0   1   0   

  

 

PROCEDURE:  

1. Arrange the bench setup without connecting circulator and measure the input power.  

2. Now connect the circulator and note down the output power at port 2 & port 3.  

3. Substitute the values to estimate the S – matrix of circulator.  

Measurement of insertion loss: 

4. Remove the circulator from slotted line and connect the detector mount to the slotted 

section. The output of the detector mount should be connected with CRO. 

5. Set any reference level of output in CRO with the help of variable attenuator, Let it be V1. 

6. Carefully remove the detector mount from slotted line without disturbing the position of 

set up. Insert the circulator between slotted line and detector mount. Keep input port to 

slotted line and detector its output port. A matched termination should be placed at third port. 

7. Record the output in CRO, Let it be V2. 

8. Compute Insertion loss given as V1-V2 in db. 

Measurement of Isolation: 

9. The circulator has to be connected in reverse i.e. output port to slotted line and detector to 

input port with other port terminated by matched termination. 

10. Record the output in CRO. Let it be V3. 

11. Compute Isolation as V1-V3 in db. 

12. The same experiment can be done for other ports of circulator. 

 

 

RESULT:   The S-parameters and performance characteristics of circulator were determined. 

 

 

 

Viva Questions 

 

1. ________ is a three-port microwave device that can be lossless and matched at all 

spots. 

2. The total number of ones in the scattering matrix of an ideal circulator is............ 

3. In the scattering matrix representation of a non-ideal circulator, the diagonal elements 

of the matrix are.................... 

4. Practically, opposite circulatory in a ferrite circulator can be obtained by...................... 

5.  What is a common mechanical analog of ferrimagnetic resonance? 

6.  What explains nonreciprocal action in ferrites? 

7.  What explains nonreciprocal action in semiconductors? 

8. What are ferrites? 

9.  In which resonance region do most waveguide circulators operate? 

10. Which type of circulator typically has the highest power handling capability? 
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11.  What is the primary difference between a circulator and an isolator? 

12. How important is the microwave transmission medium (waveguide, stripline, coaxial 

line) in ferrite selection? 

13. What is the primary characteristic of a circulator? 
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II. Introduction to HFSS 

what is HFSS? 

HFSS is a high-performance full-wave electromagnetic(EM) field simulator 

for arbitrary 3D volumetric passive device modeling that takes advantage of the familiar 

Microsoft Windows graphical user interface. It integrates simulation, visualization, solid 

modeling, and automation in an easy-to-learn environment where solutions to your 3D EM 

problems are quickly and accurately obtained. 

Ansoft HFSS employs the Finite Element Method(FEM), adaptive meshing, and brilliant 

graphics to give you unparalleled performance and insight to all of your 3D EM problems. 

Ansoft HFSS can be used to calculate parameters such as S-Parameters, Resonant Frequency, 

and Fields.  

Typical uses include: 

● Package Modeling – BGA, QFP, Flip-Chip 

● PCB Board Modeling – Power/Ground planes, Mesh Grid Grounds, Backplanes. 

● Silicon/GaAs - Spiral Inductors, Transformers 

● EMC/EMI – Shield Enclosures, Coupling, Near- or Far-Field Radiation 

● Antennas/Mobile Communications – Patches, Dipoles, Horns, Con formal Cell Phone 

Antennas, Quadrafilar Helix, Specific Absorption Rate(SAR), Infinite Arrays, Radar 

Cross Section(RCS), Frequency Selective Surfaces(FSS) 

● Connectors – Coax, SFP/XFP, Backplane, Transitions 

● Wave guide – Filters, Resonators, Transitions, Couplers 

● Filters – Cavity Filters, Microstrip, Dielectric 

● HFSS is an interactive simulation system whose basic mesh element is a tetrahedron. 

This allows you to solve any arbitrary 3D geometry, especially those with complex 

curves and shapes, in a fraction of the time it would take using other techniques. 

● The name HFSS stands for High Frequency Structure Simulator. Ansoft pioneered the 

use of the Finite Element Method(FEM) for EM simulation by developing/implementing 

technologies such as tangential vector finite elements, adaptive meshing, and Adaptive 

Lanczos-Pade Sweep(ALPS). Today, HFSS continues to lead the industry with 

innovations such as Modes-to-Nodes and Full-Wave Spice™. 
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● Ansoft HFSS has evolved over a period of years with input from many users and 

industries. 

●  In industry, Ansoft HFSS is the tool of choice for high-productivity research, 

development, and virtual prototyping. 

System Requirements 

● Microsoft Windows XP(32/64), Windows 7 or above Server. For upto-date information, 

refer to the HFSS Release Notes. 

● Pentium –based computer 

● 128MB RAM minimum 

● 8MB Video Card minimum 

● Mouse or other pointing device 

● CD-ROM drive 

Starting Ansoft HFSS 

1. Click the Microsoft Start button, select Programs, and select the Ansoft, HFSS 15. 

program group. Click HFSS 15. 

2. Or Double click on the HFSS 15 icon on the Windows Desktop 

 

Getting Help: 

If you have any questions while you are using Ansoft HFSS you can find answers in several 

ways: 
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i. Ansoft HFSS Online Help provides assistance while you are working. 

ii. To get help about a specific, active dialog box, click the Help button in the dialog box or 

press the F1 key. 

iii. Select the menu itemHelp > Contents to access the online help system. 

iv. Tooltips are available to provide information about tools on the toolbars or dialog boxes. 

When you hold the pointer over a tool for a brief time, a tooltip appears to display the 

name of the tool. 

v. As you move the pointer over a tool or click a menu item, the Status Bar at the bottom of 

the Ansoft HFSS window provides a brief description of the function of the tool or menu 

item. 

vi. The Ansoft HFSS Getting Started guide provides detailed information about using HFSS 

to create and solve 3D EM projects. 

Ansoft Technical Support: 

I. To contact Ansoft technical support staff in your geographical area, please log on to the 

Ansoft corporate website, www.ansoft.com and select Contact. 

II. Your Ansoft sales engineer may also be contacted in order to obtain this information. 

Ansoft Terms 

The Ansoft HFSS window has several optional panels: 

● A Project Manager which contains a design tree which lists the structure of the project. 

● A Message Manager that allows you to view any errors or warnings that occur before 

you begin a simulation. 

● A Property Window that displays and allows you to change model parameters or 

attributes. 

● A Progress Window that displays solution progress. 

● A 3D Modeler Window which contains the model and model tree for the active design. 
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Project Manager: 
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Property Window: 

 

Ansoft 3D Modeler: 
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3D Modeler Design Tree: 
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Design Windows 

i. In the Ansoft HFSS Desktop, each project can have multiple designs and each design is 

displayed in a separate window. 

ii. You can have multiple projects and design windows open at the same time. 

iii. Also, you can have multiple views of the same design visible at the same time. 

iv. To arrange the windows, you can drag them by the title bar, and resize them by dragging 

a corner or border. Also, you can select one of the following menu options: 

v. Window >Cascade, Window >Tile Vertically, or Window > Tile Horizontally. 

vi. To organize your Ansoft HFSS window, you can iconize open designs. Click the Iconize 

** symbol in the upper right corner of the document border.  

vii. An icon appears in the lower part of the Ansoft HFSS window. If the icon is not visible, 

it may be behind another open document. Resize any open documents as necessary. 

viii. Select the menu item Window > Arrange Icons to arrange them at 

the bottom of the Ansoft HFSS window. 

ix. Select the menu item Window > Close All to close all open design. You are prompted to 

Save unsaved designs. 

Toolbars: 

The toolbar buttons are shortcuts for frequently used commands. Most of the available 

toolbars are displayed in this illustration of the Ansoft HFSS initial screen, but your Ansoft 

HFSS window probably will not be arranged this way. 

You can customize your toolbar display in a way that is convenient for you. 

.
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To display or hide individual toolbars: 

i. Right-click the Ansoft HFSS window frame. 

ii. A list of all the toolbars is displayed. The toolbars with a check mark 

iii. beside them are visible; the toolbars without a check mark are hidden. 

iv. Click the toolbar name to turn its display on or off 

v. To make changes to the toolbars, select the menu item Tools > Customize.  

vi. See Customize and Arrange Toolbars on the next page. 

Ansoft HFSS Desktop: 

The Ansoft HFSS Desktop provides an intuitive, easy-to-use interface for 

developing passive RF device models. Creating designs, involves the following: 

1. Parametric Model Generation – creating the geometry, boundaries and 

Excitations. 

2. Analysis Setup – defining solution setup and frequency sweeps 

3. Results – creating 2D reports and field plots 

4. Solve Loop - the solution process is fully automated 

To understand how these processes co-exist, examine the illustration shown below. 
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Opening a HFSS project: 

This section describes how to open a new or existing project. Opening a New project 

To open a new project: 

1. In an Ansoft HFSS window, select the menu item File > New. 

2. Select the menu Project > Insert HFSS Design. 

Opening an Existing HFSS project 

To open an existing project: 

1. In an Ansoft HFSS window,select the menu File > Open. 

Use the Open dialog to select the project. 

2. Click Open to open the project 

Opening an Existing Project from Explorer: 

You can open a project directly from the Microsoft Windows Explorer. 

1. To open a project from Windows Explorer, do one of the following: 

2. Double-click on the name of the project in Windows Explorer. 
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3. Right-click the name of the project in Windows Explorer and select 

4. Open from the shortcut menu. 

 

 

Set Solution Type 

This section describes how to set the Solution Type. The Solution Type defines the type of 

results, how the excitations are defined, and the convergence. The following Solution Types 

are available: 

1. Driven Modal - calculates the modal-based S-parameters. The S-matrix solutions will be 

expressed in terms of the incident and reflected powers of waveguide modes. 

2. Driven Terminal - calculates the terminal-based S-parameters of 

transmission line ports. The S-matrix solutions will be expressed 

in terms of terminal voltages and currents. 

3.Eignemode – calculate the eigenmodes, or resonances, of a structure. The Eigenmode 

solver finds the resonant frequencies of the structure and the fields at those resonant 

frequencies. 

Convergence 

Driven Modal – Delta S for modal S-Parameters. This was the only convergence method 

available for Driven Solutions in  previous versions. 
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Driven Terminal – Delta S for the single-ended or differential nodal SParameters. 

Eigenmode - Delta F 

 

 

To set the solution type: 

1. Select the menu item HFSS > Solution Type 

2. Solution Type Window: 

3. Choose one of the following: 

a) Driven Modal 

b) Driven Terminal 

c) Eigenmode 

5. Click the OK button. 

Parametric Model Creation 

● The Ansoft HFSS 3D Modeler is designed for ease of use and flexibility. The power of 

the 3D Modeler is in its unique ability to create fully parametric designs without editing 

complex macros/model history. 

● The purpose of this chapter is to provide an overview of the 3D Modeling capabilities. 

By understanding the basic concepts outlined here you will be able to quickly take 

advantage of the full feature set offered by the 3D Parametric Modeler. 

Overview of the 3D Modeler User Interface 

The following picture shows the 3D Modeler window. 
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● 3D Modeler Design Tree – The 3D Modeler Design Tree is an essential part of the user 

interface. From here you may access the structural elements in addition to any object 

dependencies and attributes. 

● Context Menus – Context menus are a flexible way of accessing frequently used menu 

commands for the current context. The contents of these menus change dynamically and 

are available throughout the interface by clicking the right mouse button. 

● Graphics Area – The graphics area is used to interact with the structural elements. 

 

When using the 3D Modeler interface you will also interact with two additional interfaces: 

Property Window – The Property Window is used to view or modify the attributes and 

dimensions of structural objects 

Status Bar/Coordinate Entry – The Status Bar on the Ansoft HFSS Desktop Window 

displays the Coordinate Entry fields that can be used to define points or offsets during the 

creation of structural objects. 
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Grid Plane 

● To simplify the creation of structural primitives, a grid or drawing plane is used. 

● The drawing plane does not in any way limit the user to two dimensional coordinates but 

instead is used as a guide to simplify the creation of structural primitives. The drawing 

plane is represented by the active grid plane (The grid does not have to be visible). To 

demonstrate how drawing planes are used, review the following section: Creating and 

Viewing Simple Structures. 

Active Cursor 

● The active cursor refers to the cursor that is available during object creation. The cursor 

allows you to graphically change the current position. The position is displayed on the 

status bar of the Ansoft HFSS Desktop Window. 

● When objects are not being constructed, the cursor remains passive and is set for 

dynamic selection. See the Overview of Selecting Objects for more details. 

Creating and Viewing a Simple Structure 

Creating 3D structural objects is accomplished by performing the following steps: 

1. Set the grid plane 

2. Create the base shape of the object 

3. Set the Height 
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Create a Box 

We will investigate creating a box to demonstrate these steps. These steps assume that project 

and a HFSS design have already been created. Thre points are required to create the box. The 

first two form the base rectangle and the third sets the height. 

Point 1: Defines the start point of the base rectangle. 

Point 2: Defines the size of the base rectangle. 

Point 3: Defines the height of the Box. 

 

1. Select the menu item 3D Modeler > Grid Plane > XY 

2. Use the mouse to create the base shape 

a) Set the start point by positioning the active cursor and click the left 

mouse button. 
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b) Position the active cursor and click the left mouse button to set the second point that 

forms the base rectangle. 

 

 

c) Set the Height by positioning the active cursor and clicking left mouse button. 
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Specifying Points 

Grid 

● From the example, we saw that the simplest way to set a point is by clicking its position 

on the grid plane. To set the precision of the grid plane,select the menu item View > Grid 

Settings. From here you may specify the Grid Type, Style, Visibility, and Precision.  

 

● By pressing the Save As Default button, you can set the default behavior for future HFSS 

Designs. 
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Coordinate Entry 

Another way to specify a coordinate is to use the Coordinate Entry fields which are located 

on the status bar of the Ansoft HFSS Desktop. The position may be specified in Cartesian, 

Cylindrical, or Spherical coordinates. Once the first point is set, the Coordinate Entry will 

default to Relative coordinates. In Relative mode the coordinates are no longer absolute 

(measured from the origin of the working coordinate system), but relative to the last point 

entered. 

Equations 

The Coordinate Entry fields allow equations to be entered for position values. Examples: 2*5, 

2+6+8, 2*cos(10*(pi/180)). Variables are not allowed in the Coordinate Entry Field. 

Note: Trig functions are in radians 

 

 

 

Object Properties 

By default the Properties dialog will appear after you have finished sketching an object. The 

position and size of objects can be modified from the dialog. This method allows you to 

create objects by clicking the estimated values using the mouse and then correcting the values 

in the final dialog. 

The Property dialog accepts equations, variables, and units. See the Overview of Entering 

Parameters for more detail. 

Every object has two types of properties 

1. Command – Defines the structural primitive 



METHODIST COLLEGE OF ENGINEERING AND TECHN0LOGY 

 

65 | P a g e  
BE CBCS VII SEM MW LAB MANUAL (E&CE) 
 

 

2. Attributes – Defines the material, display, and solve properties 

 

Overview of Draw 

 

Primitives: 

In solid modeling, the basic element or object is often called a primitive. 

Examples of primitives are boxes, cylinders, rectangles, circles, etc. There are two types of 

primitives:  

1. 3D primitives or solids  

2. 2D primitives or surfaces.  

● By placing a collection of primitives in the correct location and of the correct size we can 

create a represent complex structural objects. 



METHODIST COLLEGE OF ENGINEERING AND TECHN0LOGY 

 

66 | P a g e  
BE CBCS VII SEM MW LAB MANUAL (E&CE) 
 

● To create complex objects, primitives can be used as “tools” to cut holes, carve away, or 

join. The operations that are performed with these “tools” are often referred to as 

Boolean operations. 

● 2D primitives can be swept to create arbitrarily shaped solid primitives. 

2D Draw Objects: 

The following 2D Draw objects are available: 

a) Rectangle, Circle, Line, Point, Spline, Ellipse, Regular Polygon (v8.5 

circle) 

3D Draw Objects: 

The following 3D Draw objects are available: 

a) Box, Cylinder, Sphere, Torus, Helix, Bond Wire, Cone, Regular 

Polyhedron (v8.5 cylinder) 

True Surfaces: 

Circles, Cylinders, Spheres, etc are represented as true surfaces. In versions prior to 

release 9, these primitives would be represented as faceted objects. If you wish to use the 

faceted primitives (Cylinders or Circles), select the Regular Polyhedron or Regular Polygon. 

To control the mesh generation of true surfaces objects, see the section on Mesh Control. 

Snap Mode: 

As an aid for graphical selection, the modeler provides Snap options. The default is to snaps 

are shown here. The shape of the active cursor will dynamically change as the cursor is 

moved over the snap positions. 

Moving: 

By default all active cursor movement is in three dimensions. The modeler can also be 

set to allow the active cursor to only move in a plane or out of plane. These are set from the 

menu item 3D Modeler > Movement Mode. In addition, the movement can be limited to a 

specific direction (x, y, or z) by holding down the x, y, or z key. This prevents movement in 

the other directions. 
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Pressing the CTRL+Enter key sets a local reference point. This can be useful for 

creating geometry graphically that is based on an existing objects. This is outlined on the next 

page: 

 

 

 

Step 1: Start Point 

 

 

Step 2: Hold X key and select vertex point 
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Step 3: CTRL+Enter Keys set a local reference. 

 

 

Step 4: Hold Z key and set height. Overview of Draw: 

Import: 

In 3D modeler you can import a drawing file from outside. 

Choose option 3D Modeler -> Import . Here is the list of import files that we support. For 

some of these import option you will need an add-on translator feature in your license file. 

Healing: 

Automated healing for imported solid models ,Post-translation user controlled healing 

3D Model Analysis – 3D Modeler/Analyze: 

Face, Object , Area analysis based on user inputs 
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List of problems (faces, edges, vertices) 

a) Auto Zoom In into region where problem exists 

b) Remove Face 

c) Remove Edge 

d) Remove Sliver 

e) Remove Vertices 

Selecting Previously Defined Shapes You may select an object by moving the mouse over the 

object in the graphics area and clicking on it. The default mode is Dynamic selection which 

will display the object to be selected with a unique outline color. Please note that after 

selecting (Clicking on the object) the object it will be displayed solid pink while all other 

objects are drawn transparent. 

Types of Selection 

The default is to select objects. Sometimes is necessary to select faces, edges, or vertices. 

To change the selection mode, select the menu item Edit > Select and choose the appropriate 

selection mode. The shortcut keys o (Object selection) and f (face selection) are useful for 

quickly switching between the most common selection modes. 

Multiple Select or Toggle Selection 

 Multiple objects can be selected graphically by holding down the CTRL key while 

selecting. In addition, with the CTRL key pressed, the selection of an object can be toggled 

between selected or unselected. 

Blocked Objects 

If the object you wish to select is located behind another object, select the object that is 

blocking the desired object and press the b key or right-click and select Next Behind from the 

context menu. You may repeat this as many times as needed to select the correct object.Select 

All Visible You can select all visible objects by pressing the CTRL+a key or by selecting the 

menu item Edit > Select All Visible. Select by Name 

To select objects by Name you can use anyone of the following: 

● Select the menu item Edit > Select > By Name. 

● Select the menu item HFSS > List. 
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● Select the Model tab. 

● Select objects from the list. 

● Use the Model Tree. See the next page. 

Model Tree 

After an object has been created, it is automatically added to the Model Tree. All objects can 

be found in the Model Tree. If you open the Model folder you will find the objects sorted by 

Object or by Material. You can toggle between the views by toggling the menu item 3D 

Modeler > Group Object by Material. 

 

 

As stated previously, every object has two types of properties: 

Attributes: 

You may select an object by clicking on the corresponding item in the Model Tree. 

When the object is selected the attributes will be displayed in the Property Window. Double-

clicking on the object will open a properties dialog. Use the Property Window or properties 

dialog to modify the attributes. 

Commands: 

From the Model Tree, the Command Properties can be selected by expanding the object 

folder to display the command list. Using the mouse, select the corresponding command from 

the tree. The properties will be displayed in the Property Window. Double-clicking on the 

command will open a properties dialog. Use the Property Window or properties dialog to 

modify the command. 

When the command is selected, the object will be outlined with bold lines in the 3D Model 

Window. Since an object can be a combination of several primitives, the command list may 
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contain several objects. Anyone of these commands can be selected to visualize or modify the 

object. 

 

 

Model Tree: 

Geometry in the 3D modeler is also grouped according to their model definition. Objects, 

Sheets, Lines, and Points are all separated so that they can be easily identified in the model 

tree. 
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If a boundary condition or an excitation is defined on a sheet object, then those 2D objects 

will be further separated according to their assignment. 

 

Object Attributes: 

An objects attributes set the following user defined properties: 

Name – User defined name. Default names start with the primitive  type followed by an  

increasing number: Box1, Box2, etc. 

Material – User defined material property. The default property is vacuum. This can be 

changed by using the material toolbar. 

Solve Inside – By default HFSS only solves for fields inside 

dielectrics. To force HFSS to solve inside conductors, check 

solve inside. 

Orientation 

Model Object – Controls if the object is included in the solve 

Display Wireframe – Forces the object to always be displayed as wireframe 

Color – Set object color 

Transparency – Set the transparency of an object. 0–Solid, 1-Wireframe 
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Note: Visibility is not an object property. 

 

Materials 

By clicking on the property button for the material name, the material definition window 

will appear. You can select from the existing database or define a custom project material. 
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User Defined Project Material 

To define a custom material click the Add Material button from the material 

definition window. The following dialog will appear. Enter the material definitions and click 

the OK button. 
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Changing the View 

You can change the view at any time (even during shape generation) by using the following 

commands: 

Toolbar 

● Rotate – The structure will be rotated around the coordinate system 
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● Pan – The structure will be translated in the graphical area 

● Dynamic Zoom – Moving the mouse upwards will increase the zoom factor while 

moving the mouse downwards will decrease the zoom factor 

● Zoom In/Out – In this mode a rubber band rectangle will be defined by dragging the 

mouse. After releasing the mouse button the zoom factor will be applied. 

 

Context Menu 

Right click in the graphics area and select the menu item View and choose from the 

options outlined in the Toolbar section. The context menu also offers the following: 

Fit All – This will zoom the defined structure to a point where it fits in the drawing area 

Fit Selection – This fits only the selected objects into the drawing area. 

Spin – Drag the mouse and release the mouse button to start the object spinning. The speed 

of the dragging prior to releasing the mouse controls the speed of the spin. 

Animate – Create or display the animation of parametric geometry  

Shortcuts: 

Since changing the view is a frequently used operation, some useful shortcut keys exist. Press 

the appropriate keys and drag the mouse with the left button pressed: 

ALT + Drag – Rotate 

In addition, there are 9 pre-defined view angles that can be selected by holding the ALT key 

and double clicking on the locations shown. 

Shift + Drag - Pan 

ALT + Shift + Drag – Dynamic Zoom 
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Visibility: 

The visibility of objects, Boundaries, Excitations, and Field Reports can be controlled 

from the menu item View > Visibility 

Hide Selection: 

The visibility of selected objects can be set hidden by selecting the object(s) and choosing 

the menu View > Hide Selection > All Views. 

Rendering: 

To change the rendering select the menu item View > Render > Wireframe or View > 

Render > Smooth Shaded 

Coordinate System: 

To control the view of the coordinate system, select the menu item: 

Visibility: 

Toggle the menu item View > Coordinate System > Hide(Show) 
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Size: 

Toggle the menu item View > Coordinate System > Small 

(Large) 

Background Color: 

To set the background color, select the menu item View > Modify  

Attributes> Background Color 

Addition View Settings: 

Additional attributes of the view such as the projection, orientation, and lighting can be set 

from the menu item View > Modify Attributes. 

Enhancements and New Features 

Selection: 

Select Connected Vertices 

Select Connected Faces 

Select Connected Edges 

Select Edge Chain 

Select Face Chain 

Select Uncovered Loops 

Healing: 

Purge History – makes an object appear as an 

imported entity so that healing can be performed on it 

Remove Faces 

Remove Edges 

Remove Vertices 
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Align Faces Enhancements and New Features 

Visibility 

● Hide selected objects in Active View 

● Hide selected objects in All Views 

● Show selected objects in Active View 

● Show selected objects in All Views 

3D User Interface Options 

● When there is a selection 

● Selection is always visible 

● Set transparency of selected objects 

● Set transparency of non-selected objects 

● Default Rotation About 

● Screen Center 

● Current Axis 

● Model Center 

3D Modeler Options 

Visualize history of objects 

 

Applying Structural Transformations 
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So far we have investigated hot to model simple shapes and how to change the view of the 

model. To create more complicated models or reduce the number of objects that need to be 

created manually we can apply various transformations. 

The following examples assume that you have already selected the object(s) that you wish 

to apply a transformation. 

You can select the transformation options from the menu item:  

Edit > 

Arrange > 

● Move – Translates the structure along a vector 

● Rotate – Rotates the shape around a coordinate axis by an angle 

● Mirror – Mirrors the shape around a specified plane 

● Offset – Performs a uniform scale in x, y, and z. 

Duplicate > 

● Along Lines – Create multiple copies of an object along a vector 

● Around Axis – Create multiple copies of an object rotated by a fixed angle around the x, 

y, or z axis 

● Mirror - Mirrors the shape around a specified plane and creates a duplicate 

● Scale – Allows non-uniform scaling in the x, y, or z direction 

The faces of an object can also be moved to alter the shape of an existing object. 

To move the faces of an object select the menu item 3D Modeler > Surfaces >Move 

Faces and select Along Normal or Along Vector. 

Combine Objects by Using Boolean Operations: 

Most complex structures can be reduced to combinations of simple primitives. Even the solid 

primitives can be reduced to simple 2D primitives that are swept along a vector or around an 

axis(Box is a square that is swept along a vector to give it thickness). The solid modeler 

supports the following Boolean operations: 

● Unite – combine multiple primitives 

a) Unite disjoint objects 
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b) Separate Bodies to separate 

● Subtract – remove part of a primitive from another 

● Split – break primitives into multiple parts 

● Intersect– keep only the parts of primitives that overlap 

● Sweep – turn a 2D primitive into a solid by sweeping: Along a Vector, Around an Axis, 

Along a Path 

● Connect – connect 2D primitives. Use Cover Surfaces to turn the connected object into a 

solid 

● Section – generate 2D cross-sections of a 3D object 

● Most Boolean operations require a base primitive in which the Boolean operation is 

performed. Only the base object will be preserved. 

● The Boolean functions provide the option to Clone objects. 

● Split Crossing Objects – When a group of objects are selected, a Boolean split is 

performed on ANY objects that overlap. 

Local Coordinate Systems 

The ability to create local coordinate systems adds a great deal of flexibility to the 

creations of structural objects. In previous sections we have only discussed objects that are 

aligned to the global coordinate system. The local coordinate system simplifies the definition 

of objects that do not align with the global coordinate system. In addition, the object history 

is defined relative to a coordinate system. If the coordinate system is moved, the geometry 

will automatically move with it. The definition of coordinate systems are maintained in the 

Model Tree. 

Working Coordinate System 

The working coordinate system is the currently selected CS. This can be a local or global 

CS 

Global CS 

● The default fixed coordinate system 

Relative CS 

● User defined local coordinate system. 

a) Offset 
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b) Rotated 

c) Both 

Face CS 

User defined local coordinate system. It is tied to the location of the object face it was 

created on. If the size of the base object changes, all objects created relative to the face CS 

will be updated automatically. 

To create a face CS, select the menu item 3D Modeler > Coordinate 

System > Face 

1. Graphically select Face (Highlighted in model) 

2. Select Origin for Face CS 

3. Set X-Axis  
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Example of Face CS: 

 

Cone is created with Face CS 
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Change the size of the box and the Cone is automatically moved with the Face CS Parametric 

Geometry 

The parametric modeler capability allows us to define variables in replace of a fixed 

position or size. Once this has been defined the variable can be changed by the user or by 

Optimetrics. Optimetrics can then be used to perform automatic Optimization, Parametric 

Sweeps, Statistical, or Sensitivity Analysis. 

Defining Parameters 

● Select the command to parameterized 

● Choose the value to change 

● Enter a variable in replace of the fixed value 

● Define the variable using any combination of math functions or design variables. 

The model will automatically be updated. 

 

 

 

 

Variables: 

There are two types of 

variables that can be defined in 

the HFSS Desktop 

● Design Properties – Local 

to model. To access the 

local variables select the 

menu item HFSS > Design Properties. 

● Project Variables – Global to all models in project. Start with $. To access the global or 

project variables, select the menu item Project >Project Variables 

Units: 
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When defining variables they must contain units. The default units for variables is meters. 

Equations: 

The variables can contain complex equations. See the Online Help for a complete list of 

math functions 

Equation based Curves and Surfaces: 

Any curve/surface that can be described by an equation in three dimensions can bedrawn. 

 

 

   

 

 

Animation: 

Right-Click in the 3D Model Window & Choose Animate to preview the 

parameterization 

Note: depending on the quality of your graphics card you have the option of exporting ether 

AVI or GIF animation files. 
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EXPERIMENT-9 

DESIGN AND SIMULATE A HALFWAVE DIPOLE ANTENNA 

Aim: To design a Halfwave dipole antenna at a frequency of 1GHz and simulate its 

behaviour. 

Software Used: HFSS 

Procedure: 

1. Initially after deciding the operating frequency calculate the wavelength using  

where f is the operating frequency. 

2. Now calculate the half wavelength to assign it as the length of the dipole antenna. 

3. Excluding the port the dipole has two segments each of Quarter wavelength that 

combined gives total length of antenna to be . 

4. Select the shape of the segment i.e. cylinder and define the dimensions (Frequently used 

measurements can be declared as parameters). 

5. Now select the material of the dipole and construct it using the preset dimensions. 

6. Create a component called gap with an approximate dimension of 1~2mm exactly at the 

center of the dipole with material as vacuum and perform subtract operation from the 

tool bar there by creating a gap. 

7. Now select the gap component and go to Modeller →Surface → Section in tool box and 

select the axis this will create a cross section between two quarterwave parts acting as a 

port. 

8. Define a lumped port with a default resistance of 50 ohms and define a new integration 

line by choosing the bottom and top edge of rectangular section at the gap. 

9. Create a PML open region to set a dielectric and vacuum simulation atmosphere and 

designate the frequency. 

10. Analyse the designed dipole by assigning a frequency sweep around the frequency of 

operation. 

Model Figures: 

 

Fig 1: Halfwave Dipole 
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FIG2: Return loss at 1GHz 

 

 

 

FIG3: Polar Graph of Radiation Pattern 
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FIG4: 3D Farfield plot at 1GHz 

 

Calculations: 

Wavelength=  

Half wavelength=  

Gap=1~2mm 

 

Results: Halfwave dipole antenna has been successfully designed in HFSS and the results 

have been simulated at 1GHz.   
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Viva Questions 

 

1. What is the range of frequency in half dipole antenna? 

2.  What are the advantages of half dipole antenna 

3. Explain the radiation pattern of half dipole antenna 

4. The impedance at the center of the antenna is known as? 

5. The type of dipole antenna that has a higher band width is called as? 

6. The radiation pattern of a half-wave dipole has the shape of a ______ 

7.  What is the beam width for a half wave dipole antenna? 

8. What does the beam width of an antenna tell us? 

9.  What is the power radiated by the antenna with gain called as? 

10. What is the impedance of the folded dipole antenna? 

11. A dipole antenna is also called as? 
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EXPERIMENT 11 

DESIGN AND SIMULATION OF MICROWAVE PATCH ANTENNA AT 2.4GHZ 

Aim: To design and simulate a microwave patch antenna at a frequency of 2.5GHz in HFSS. 

Software used: HFSS 

Procedure: 

1. Initially after deciding the operating frequency and the material being used for substrate 

calculate the Length and Width of the patch . 

2. Now calculate the length and width of the antenna feed line depending on the dielectric 

constant and electric angle.  

3. Calculate the feed depth for an Inset feed type patch antenna. 

4. After declaring these as standard parameters in the software start designing the patch 

antenna as layers. 

5. Select the Substrate as FR-4 Lossy and set the thickness to 1.6mm and the length and 

width should be considerably greater than the dimensions of the patch(  difference on 

all sides is recommended) 

6. Create a component called patch and give it the dimensions as calculated earlier and set 

the thickness of the patch to a maximum of th  of the substrate thickness.  

7. Now create a ground plane using the same dimensions as substrate for length and width 

but the thickness should be equal to that of patch. 

 

8. Define a component called feed line and design it with pre calculated dimensions(see to 

it that the length of the feed is sufficient enough to extend till lower end of substrate 

plane).  

9. Now using the ADD feature in the transform toolbox combine the patch and the feed line 

with each other. 

10. Now select the gap component and go to Modeller →Surface → Section in tool box and 

select the axis this will create a cross section between two quarterwave parts acting as a 

port. 

11. Define a lumped port with a default resistance of 50 ohms and define a new integration 

line by choosing the bottom and top edge of rectangular section at the end of feed. 

12. Create a PML open region to set a dielectric and vacuum simulation atmosphere and 

designate the frequency. 

13. Analyse the designed patch antenna by assigning a frequency sweep around the 

frequency of operation. 
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Model Figures : 

 

 

 

FIG1: Patch antenna 

 

 

 

FIG 2: Return loss at 2.5GHz 
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FIG 3: Polar Radiation patter on antenna 

 

Calculations: 

Width of patch(w)=      

Where  is relative permittivity of substrate 

 

Length of patch(l)=  

 

 

Where Leff =  

 

And normalized length extension  is given by 
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=  

Feed Length =  

Where guided wavelength( ) =  

Lg=L+6h 

Wg=W+6h 

If Radiation box is to be manually created: 

Axis Position=  

Length =  

Width =  

Height =  

 

Results: Microwave Patch antenna antenna has been successfully designed in HFSS and the 

results have been simulated at 2.5GHz. 

 

 

 

Viva Questions 

 

1. Patch antennas are the antennas of small size and are made of _______________ 

2. An antenna source that radiates energy uniformly in all the directions is 

called_________________________- 

3. Microstrip feeding of the microstrip antenna …………………….. 
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4. In the moment method analysis of the patch antenna ……………………. 

5. How to reduce beawidth for a single patch antenna? 

6. What is the possible range of height for the occurrence of sporadic E-region with 

respect to normal E-region? 

7. How does patch antenna work? 

8. What type of antenna is patch antenna? 

9. What would happen if the rms value of induced emf in loop acquires an angle θ = 

90°? 

10. If the elements of a binomial array are separated by λ/4, how many shape 

patterns are generated with no minor lobes? 
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BEYOND SYLLABUS 

 

 

1. To study the phase shifter 

AIM : - To study the phase shifter. 

APPARATUS REQUIRED :- Microwave source, Isolator, Variable attenuator, Frequency 

meter, Slotted line, Tunable probe, Phase shifter, Movable short, VSWR meter, Cables and 

Accessories 

THEORY: - A phase shifter consists of a piece of waveguide and a dielectric material inside 

the waveguide placed parallel to Electric vector of TElO mode. The phase changes, as a piece 

of dielectric material is moved from edge of waveguide towards the centre of the waveguide. 

BLOCK DIAGRAM: - 
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PROCEDURE: - 1. Set up the equipment as shown in the Fig.   

2. First movable short is placed at the end of slotted line.   

3. Energize the microwave source for maximum output at particular frequency of operation.   

4. Find out the !g with the help of tunable probe slotted line and VSWR meter. It is the twice 

the distance between two minima on the slotted line.  

5. Find out the operating frequency for frequency meter or by relation of λg 

6. Find out  λ  as 

     λ = c/f                                                      1/ λ 2 = 1/ λ g 2 + 1/ λ c 2 

7. Note and record a reference minima position on the slotted line. Let it is X.  

 8. Remove carefully the movable short from the slotted line without disturbing any position 

on the set up, place the phase shifter to the slotted line with its micrometer reading zero and 

then place the movable short to the other port of phase shifter.  

9. Find out a new minima position let it is Y. 

10. Change the position of micrometer of phase shifter and find out the corresponding 

position of new minima, let it is Yi. 

CALCULATION : Since new minima is multiple of half wave-length from the short, it 

should be possible to calculate the exact electrical length of phase shifter. For example 

suppose at 10 GHz a reference minima is found at X = 16.08 cm. Now suppose that phase 

shifter is two wave-lengths long and placed on the line as in step 8, the new minima y = 14.90 

cm is obtained. Hence, short has apparently moved 16.08 - 14.90 = 1.18 cm. This can be 

written in form of as ! (.393) = (1.18) !/3 Since the apparent movement is in the direction the 

short actually moved, it is added to the approximate number of half wave length in the phase 

shifter. The total electrical length is 2.393 wave lengths. The phase shift in radians is found as 

below: Multiply by 2 $ to give phase shift in radius or by 3600 to give phase shift in degrees. 

Phase shift in above example = 2 $ x 2.393 radians = 360 x 2.393 degrees The phase shift for 

other micrometer reading position can be found as above. 

 

RESULTS: 
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Viva Questions 

1.Phase shifters are used in _______ where the antenna beam can be steered in space by 

electronically controlled phase shifters. 

2. The scattering matrix of a gyrator is.............................. 

3. Is Ferrite phase shifters have more advantages over FETs and diodes in using them in 

microwave integrated circuits? 

4.What is Faraday’s rotation law? 

 


